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Goals of the Exercise 

This exercise introduces you to ArcGIS Pro. You use these applications to create a map of pan 

evaporation stations in Texas, and to draw a graph of monthly pan evaporation data measured at these 

stations. The relationship between ArcGIS and MS Word and Excel is demonstrated so that you can 

create graphs in Excel, maps in ArcGIS and place the result in a Word file as a report for this homework. 

In this way, you link the spatial location of the observation sites, with the time variation of the water 

observations data at those sites.  You will also upload your results as a web map of evaporation data so 

that it can be publicly viewed. 
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Computer and Data Requirements 

To carry out this exercise, you need to have a computer which runs ArcGIS Pro version 1.2. You will also 

need an ArcGIS Organizational Account to enable you to login to ArcGIS Online.  

In the first part of this exercise using ArcGIS Pro, you will be working with the following spatial datasets:  

1. A polygon shapefile of the counties of Texas, called Counties  

2. A point shapefile of pan evaporation stations, called Evap  

3. A polygon shapefile of the state of Texas, called Texas  

These shapefiles consist of several files (e.g. evap.dbf, evap.shp, evap.shx). You can get them from this 

zip file: http://www.caee.utexas.edu/prof/maidment/giswr2016/Ex1/Ex1Data.zip  

You need to establish a working folder to do the exercise on. This can be in any convenient location on 

the computer you are working on (e.g. C:\pjruess\giswr2016\Ex1).  

After you have downloaded the zip file Ex1Data.zip double click on the file and you should see Winzip 

or other zip utility to open the file on your computer (if it doesn’t open you’ll have to unzip this file on a 

computer that has a zip utility installed). Extract all files from the zip file to the working folder that 

you’ve set up to do this exercise. You should end up with a file list that looks something like this. You 

may see these data within a sequence of folder names, and if so, click on each folder down through the 

sequence until you locate the required files. 

 

  

http://www.caee.utexas.edu/prof/maidment/giswr2016/Ex1/Ex1Data.zip
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Procedure 

Please note that the following procedure is a general outline, which can be followed to complete this 

lesson. However, you are encouraged to experiment with the program and to be creative.  

1. Viewing Shapefiles in ArcMap 

A shapefile is a homogenous collection of simple features that includes geometry and feature attributes. 

The attributes are contained in a dBase table, which allows for the joining with a feature based on the 

attribute key. 

Open ArcGIS Pro  

 

The first time you open ArcGIS Pro, you will need to sign in using your ArcGIS Online account. For 

convenience, you may want to leave the “Sign me in automatically” checkbox selected. Once in ArcGIS 

Pro, you can check whether you are logged in or not in the upper right-hand corner.  
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Once you are in ArcGIS Pro, you will want to start with a Blank template.  

 

 

Click the New Map button in the Insert tab to create a map.  

 

And you’ll see a map display open with a nice map of the United States.  Pretty cool! 
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Use the Add Data button in the Map tab to add the data for this exercise to the map display. 

 

Navigate to the folder containing the exercise data and select all three files at once by using the shift key. 

Click the Add button to add the data to your ArcMap display.  
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The display should look something like the following.  
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Let’s make sure that we can retrieve the results of these actions if we inadvertently make a mistake and 

close the application.  Use Project/Save to save the contents of the current project.   

 

 

The project will save in the initial destination provided when you created the project (Ex1_project for 

this example). There is an Ex1_project.aprx file within the project folder that contains the table of 

contents and symbology information for your map.  You can shut down ArcGIS Pro and reload the same 

map display by clicking on Ex1_project.aprx.  

 

Note that the .aprx file that is saved does not contain the map data, rather it contains references to the 

data. This means that if you move the data files and then try and load the map document, ArcGIS Pro may 

not be able to find the data.  We’ll deal with how to fix this later. 

 



9 

 

Depending on the order in which themes were added the Texas theme may lie above the Counties theme 

so you cannot see the Counties theme.  

 

Click on the Counties theme and drag it up so that it is located above the Texas theme. You’ll then get a 

display showing the counties.  
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To change the appearance of a map display, you can access the Symbology menu by selecting the Symbol 

displayed in the ArcGIS Pro table of contents and the Symbology information will open on the right side 

of the screen. Alternately, you may right-click on the layer name (ie. “Texas”) and select Symbology.  

 

Note that clicking anywhere on the blue band in the above image will work, though this will require 

selecting the Symbology tab on the bottom right portion of the screen.  
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Click on the colored square under “Current Symbol” to enable the Format Polygon Symbol options.  
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Select Properties.  

 

Now make your selections for the Color, Outline Color, and Outline Width, and click Apply at the 

bottom of the screen when finished. You can show the outline of the State of Texas more distinctly by 

using the No Color 

  

symbology for the Fill Color and then changing the Outline Color to Green and the Outline Width to 2.  
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Drag the Texas layer above the Counties layer, and you’ll see that the Counties are not obscured as they 

were before, and the State of Texas is highlighted with a nice Green outline! We are green in Texas!  If 

you have another color for your Counties, then click on the Counties symbol in the Legend and in the 

Symbol Selector window that appears select a nice green color and hit Ok to recolor your counties. 
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________________________________________________________________________ 

Helpful Tips:If you move your project folder and open your ArcGIS Pro Ex1_project.aprx file later 

from another location in your file system, you may see a red exclamation points beside your feature 

classes. If this happens, click on the red exclamation point and  relocate the file location where the 

corresponding data are now stored, and your map will display correctly again.  

 

Note that these repairs will need to be made manually for all shapefiles within the .aprx file.   
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2. Using the Project tab 

Return to the Project view by clicking on the Project tab on the lower right-hand side of the window.  

 

Add your data to the project folder using the Add Folder button under the Insert tab.  

 

Navigate to the Ex1Data folder and add the folder. 
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Click on the Folders button and navigate to where your data are stored. 

 

If you right click on a data layer, you can View Metadata for an item description.  

 

A geographic preview of the data layer is shown for each dataset on the left-hand side of the screen, with 

additional data listed on the right-hand side. Note that for these dataset there are no Item Description 

metadata.  
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Select the Map tab instead of the Project tab and you’ll get your map back again.  Now, if you right click 

on a feature class and select Properties.  

 

Then navigate to Source and Spatial Reference to view the parameters of the coordinate system of the 

data selected, in this case NAD83, or the North American Datum of 1983. This provides a rather 

complicated set of parameters that we’ll learn more about later.  
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Close Properties, right click on a feature class, and select Design/Fields to open the Fields tab.  

 

Here you’ll see a formal definition of each attribute field with its Field Name and Data Type. In this 

case, ObjectID means a special data type that indexes each feature as an object in the GIS, Geometry 

means that the Shape field has geographical coordinates stored in it, and Float and Double mean decimal 

numbers in single or double precision, respectively. There are some other data types such as Short and 

Long integers, Text and Date types that we’ll encounter later in the course.  The attributes Jan through 

Dec refer to the pan evaporation in inches during that month, and Annual is the total annual evaporation 

for the year in inches.  These values are averages compiled over a number of years (NumYear) of data 

between FirstYear and FinalYear.  The data were compiled by the Texas Water Development Board. 
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Click on the other two data layers, Evap and Texas, to preview them also.  

3. Using Base Maps from ArcGIS Online 

You may have noticed the topographic map that automatically loaded on start-up. This topographic map 

is an example of an ArcGIS Online basemap, which supplements the local GIS data we have been adding 

up to this point.  
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Use Add Basemap in the Map tab to add the Streets basemap, and you should see a background map 

change from the default topography basemap to your Texas display like that shown below. Pretty cool! 

 

To quickly get the map to center on Texas, right click on the Texas layer and select Zoom to Layer 
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Click on the Counties theme and use the Symbol Selector to change the Fill Color to “No Color” so we 

can see through it to the background map, change the border color to black, and change the border 

thickness to 1.  Click on the symbol for the Evap points and use the Symbol Selector to change the size of 

the points to 10 and the color to Red.  Let’s examine Travis County. 

 

Zoom in to Travis County using the scroll wheel or right-click and pan (up zooms in, down zooms out).  
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Zoom in to Travis County by Austin in the center of Texas, and let’s examine the evaporation site by 

Lake Travis to the Northwest of the city. Notice how more detailed information appears as you zoom in. 
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Let’s label the sites with their names. To create a label, right click on Evap and select Labeling 

Properties from the menu to open the Label Class options on the right side of the screen.  

 

Verify that Station is selected as the Label Field.  

 

At the top of the Label Class, select Symbol and Appearance, then select 16 point as the type size. Hit 

Apply at the bottom of the screen to accept changes.  
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Hit Apply to confirm these selections 

 

Now, to display the label, right click on the Evap theme and select Label from the menu.  
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Now we’ve got a nice map that shows the location of our observation site labeled with its name. 

 

If you zoom in a bit closer, you can see just where the site is located near Lake Travis. You can even see 

the access roads you’d use to go to this site.  
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Now, let’s look at some imagery for this location. Proceeding as you did before to get the Street map, use 

the BaseMap button to add data for Imagery.  

 

And now you’ll see the same information displayed against a background map of orthoimagery, and let’s 

zoom in a bit to see more detail. For the Evap theme, I have used the Properties/Label to change the 

color of my site labels from black to blue to make them easier to see against the image background. This 

is really cool stuff!  You can really get a sense of context about where this observation site is located. 

  

Use File/Save to save this map display as Ex1_project.aprx so that you can get it back later. 
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4. Accessing and Querying Attribute Data 

Let’s go back to the view we had earlier of Travis County. Use the Go Back to Previous Extent arrow 

 

to step back through the views we have just been working on, and switch back to the Streets basemap 

again. Change the Label color for the Evap sites back to Black. 

Numerical and text information stored in the fields of the shapefile tables are called attributes. To access 

attribute data of the feature at a specific location, simply click on the feature in the map you are interested 

in. In this case, click on the Lake Travis evaporation site symbology (the red point).  

In the window that pops up you’ll see the attributes of that particular feature. In this instance, what you 

see is that the data for Lake Travis cover the range from 2003 to 2010, the latitude and longitude are 

30.403 and -97.917, and the values from Jan through Dec are the mean monthly evaporation recorded at 

this location, in inches, whose annual total is an Annual of 69.36 inches.  

 

These are pan evaporation data recorded using an instrument like that shown below. The evaporation data 

were obtained from the Texas Water Development Board. Only data from 2001 onwards is used since the 

TWDB has quality control checked that information. Monthly evaporation is found by averaging the daily 
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values of evaporation read from the pan, and multiplying by the number of days in the month. If a month 

has fewer than 20 daily values recorded, it is excluded from the dataset. Only years with valid monthly 

data for all 12 months are used in computing the mean monthly and mean annual pan evaporation data 

shown in the attribute table. 

 

Viewing an Attribute Table  

To access attribute data of an entire layer in ArcGIS Pro: right click on the Evap layer name in the table 

of contents, and select Attribute Table: 

 

If you scroll down the resulting Table and click on the box to the left of FID 24, you’ll see the record that 

contains the attributes of the Lake Travis station that you identified earlier. You may have noticed that 

once you selected the row, the corresponding point was selected in the map – this is a key idea of GIS – 

map features are described by records in attribute tables. 
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To Clear a Selected feature and select a new one, click on Clear at the top of the Attribute Table.  

   

5. Selecting features from a feature class 

Selecting features from a feature class involves choosing a subset of all the features in the class for a 

specific purpose. Feature selection can be made from a map by identifying the geometric shape or from an 

attribute table by identifying the record. Regardless of how you select an object, both the shape in the map 
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and the record in the attribute table will be selected. Click on the Select/Select Features by Rectangle 

tool in the Map tab.  

 

Zoom back a bit and drag a box over the three evaporation sites in the Highland Lakes reservoir system.  

 
you’ll see both records highlighted on the map and in the attribute table. I’ve turned off the Counties layer 

(click off the check box in the map Legend)  

 
and used Show selected records at the bottom of the Attribute Table to just show the three highlighted 

stations. 
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To clear your selection, choose Clear.  

 

Clicking on Show all records, then displays all the records in the attribute table again. 
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Close the Attribute Table by clicking on the X next to the Evap tab: 

 



33 

 

6. Mapping Annual Evaporation 

Let’s suppose we want to map the values of annual evaporation recorded at the stations, rather than just 

symbolizing them by their location.  Let’s zoom out to the state of Texas again.  Right click on the Texas 

feature class and select Zoom to Layer  

 

You’ll see that there are a lot of labels showing up large in your new map.  Get rid of these by right 

clicking on the Evap layer and toggling the Label entry so that the Labels are turned off. 
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Right click on the Evap layer and select Symbology. 

 

In the Symbology section on the right-hand side, click on “Single Symbol” and change to “Graduated 

Symbols”. Change Value to “Annual” and make the Template color blue.  
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I have turned off all the other layers and added the Topographic base map to get the image below. Very 

cool! 

 

7. Making a Chart 

You can see from the map that there is some tendency for lower evaporation values near the coast and to 

the East and higher values to the West. Charts are useful because they allow you to visualize trends in 

data. Open the Evap layer attribute table.  Right-click on Evap, hover over Create Chart, and select 

Scatter Plot. 
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The next screen will allow you to indicate the data to be used in the graph. Here is a graph of the Annual 

Evaporation (Annual) of all the stations plotted against the Longitude of the station. You can see that 

there is a general trend of the evaporation increasing as you go from East to West in Texas. The color of 

the chart points is blue, the same as the map points. 

 

Hit General and edit the graph properties to make them nicer. Add a title Pan Evaporation in Texas and 

relabel the vertical axis Annual Evaporation (Inches).  
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Try some different kinds of charts, such as Bar Charts and Histograms. Note that ArcGIS Pro 

automatically sorts bar charts from highest to lowest from left to right. See http://pro.arcgis.com/en/pro-

app/help/analysis/geoprocessing/charts/bar-chart.htm for more details.  Here is a pretty cool histogram of 

the pan evaporation data, with statistical properties of the data as well. 

 

 

http://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/charts/bar-chart.htm
http://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/charts/bar-chart.htm
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If you create the same kind of graph for Evaporation and Latitude, you can see that there isn’t a tendency 

for evaporation to vary with latitude in Texas, as there is for variation of evaporation with longitude. 

 

 

Notice how with some very simple charting steps, we’ve been able to get some interesting insight into 

the character of pan evaporation in Texas. 

Save your ArcGIS Pro document Ex1_project.aprx so that you can retain this display. 
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Graphing in Excel 

Another graphing option is to make a chart in Excel using the dBase tables given by the evaporation 

shapefile. Open the evaporation attributes table Evap.dbf as a table in Excel. Use Files of Type: dBase 

files in Excel to focus only on .dbf tables when you open the table. 

 

When you open the file, you’ll see that the Station name is very wide (254 characters).  Right click on this 

column in Excel and select Column width of 30 characters to correct this. 

 

Select the stations you want to plot, copy their records to a new worksheet, delete the columns you don't 

need there, and then create a chart. Here is an example chart created this way.  
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8. Creating a Map Layout 

Now we are going to create a formal map of evaporation in Texas that includes the charts that we’ve 

created.  

Under the Insert tab, select New Layout and pick the “Letter” layout.  
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You should now see the layout frame on the bottom portion of the screen. Add a Map Frame to your 

layout by making sure the Layout is selected and then going to Insert, Map Frame/Map (the name of your 

current map).  

 

Reduce the size of the data frame in the layout (i.e., rectangle where the spatial data is contained) -- to 

make room for the graph -- by clicking on the map and moving its handlers.  

Now, in order to center your map within the map data reference, first select Layout, then click Activate.  

 

Once Activate has been clicked, the Layout display region should have a faded paper background as 

shown in the following image.  
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Next, select the Explore key and pan/zoom over the map until it is centered over Texas.  

 

When you are finished editing the map, go to Layout and select Close Activation.  

 

Now we would like to add a chart to the layout, in the empty space below the map. Note that at this time 

ArcGIS Pro does not support the addition of charts to a Layout. See https://pro.arcgis.com/en/pro-

app/help/analysis/geoprocessing/charts/share-a-chart.htm for details.  

Instead, you should snip or printscreen to capture your chart image. For details see the Helpful Tip at the 

end of this section.  

 

Save the chart image, then add the image using the Picture tool in ArcGIS Pro. To do this, click the 

Picture button (Layout must be selected), then (once Picture has been selected) click on the layout where 

you would like the picture to be placed. Navigate to your picture and resize the same way you modified 

the map data frame.   

https://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/charts/share-a-chart.htm
https://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/charts/share-a-chart.htm
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You can center your chart in the Picture window using the Picture Properties 

 

The map is shown below in ArcGIS Pro with the chart below it. It may seem as if some of your lines have 

disappeared in the chart image but that is just because of the scale of the display. 
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Keep saving your ArcGIS Pro document as you proceed through the map making steps so that if you 

mess up something you can get back the work you’ve already done. 

You can also insert a North Arrow and a Scale Bar under the Insert tab.  
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When you put up the scale bar you can select the distance units to be displayed. I have used miles. 

 

Note that if you look at the bottom right of ArcMap in Data View you see coordinates in Longitude and 

Latitude. This is an indication that the map is being displayed using geographic coordinates.  It is not 

strictly correct to use a length scale when data is displayed in geographic coordinates as lengths are 

different in the North-South and East-West directions. You will learn more about this in future classes.   

 

To change the coordinate system, right-click on the Map entry in the table of contents and select 

properties.  
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Map is the name of the Data Frame used to display information in ArcGIS Pro.  In Map Properties 

click on Coordinate System and navigate to Projected Coordinate Systems -> State Systems -> NAD 

1983 Texas Centric Mapping System Albers (Meters).  Click OK. 

 

Note that for this exercise it does not really matter which coordinate system we select, but we need a 

projected coordinate system so that the scale bar is correct. Note that the display of Texas is adjusted 

according to the new projection.  

To change the display units, select the General tab in the Map Properties and change “Display Units” 

from Decimal Degrees to Meters.  
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The above map shows corrected display units as well as a Texas map corrected to a more appropriate 

coordinate system (note the slight tilt).  

Select Text from the Insert tab to insert a Title.  
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Type the text you would like for your title, and resize the window to automatically resize the font size. 

Add a second title including your name and the date.  

 
 

Here is the resulting completed map and chart combination 
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You can export your map from ArcGIS Pro using by clicking Layout in the “Export” section under the 

Share tab. Use the TIFF option so that you have a detailed graphic image.  You can store this file as 

Ex1.TIFF in your data file.  

 

Then you can add it to a Word document using Insert/Picture and loading this .tiff file. This preserves 

the crisp resolution of the ArcMap display in a word document.   

 

 

Helpful Tip: 

A more general procedure is to simply copy the screen to the clipboard and crop out the part that you 

want, saving it to a file for later use. That is how all the images in this exercise were prepared. To copy 

any image, use the Snipping Tool in All Programs/Accessories on your Windows Desktop interface 

  

Drag the cursor around the area that you want to capture and you’ll see it copied into a new display, then 

use Paste to insert this snippet into a specific location in your document. If you only want to capture the 

active frame, press Alt + Print Screen and then Paste it to the new document.  

This approach can also be used to add a map to a chart in Excel: 
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The manipulations just described transfer objects from one application to another.  

To be turned in: An ArcMap map layout in it showing a map of Texas with gages, coupled with a graph 

showing monthly evaporation data plotted from the gages. In the presentation of information on maps 

and charts it is important to include sufficient labeling detail so that the information can be clearly and 

unambiguously interpreted. You should include a scale bar to indicate distance, a north arrow to indicate 

direction and labels or legends with units wherever they are needed to interpret map or quantitative 

values. 

9. Sharing a Map Online 

Now, let’s suppose that you would like to share your map with your colleagues. This can be done with 

ArcGIS Online by using the ArcGIS Pro interface. Before creating an online map, you’ll want to make 
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sure you’re still logged in to ArcGIS Online in your ArcGIS Pro instance (check the upper right-hand 

corner of the screen).  

 

After you’re sure you’re logged in, go to the Share tab and select Web Map.  

  

A sidebar will appear on the right where you will be able to give your map a Name, Item Description, 

and select Sharing Options. Fill out these sections, and select “University of Texas at Austin” under 

Sharing Options. This will enable all other group users to have access to your shared Web Map!  

 

 
Before sharing your map, click Analyze to check that your map has all criterion required for publishing.  
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You should receive an error that looks like this:  

 

 
 

Remember when you previously changed the map’s coordinate system to NAD 1983 (2011) Texas 

Centric Mapping System Albers (Meters)? Regrettably, this new coordinate system is different than the 

coordinate system for the basemap you are currently using (all basemaps use the WGS 1984 global 

coordinate system). Hence the service layer (the basemap using WGS 1984) has a different projection 

than the map’s projection (which you changed to NAD 1983).  

 

A basemap is required for sharing a webmap, and the ArcGIS Pro basemaps cannot be changed from 

WGS 1984; therefore, all maps must be changed to this global projection before publishing online. To 

change the map projection, go to map properties, scroll to the bottom and expand “layers” (this shows all 

projections that currently exist in any of the map’s layers), and select WGS 1984 Web Mercator 

Auxiliary Sphere. Now Analyze your map again for webmap sharing.  

 

Note: The 24041 Layer feature template warning will be ignored for this particular exercise.  

 



55 

 

 
 

Now that your error is gone, click Share to create a web map from your ArcGIS Pro map. Note that you 

will want to have the basemap display box checked so that the basemap loads properly on your webmap. 

Once you have selected Share, a loading screen should appear that looks like this:  

 

 
 

Once your web map has been successfully published you will receive a confirmation message.  

 

 
 

You can also view your webmap in the Content tab within the Sharing Web Map pane.  
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Following publishing, proceed to ArcGIS Online to view your webmap online.  
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Go to http://www.arcgis.com and sign in with your ArcGIS Online Username and Password 

 

 
 

The landing page should look similar to the screen below.  Click on "My Content"  

 

 
 

This opens a section where you can manage the content you have added to ArcGIS.com. Click on the 

Web Map file you just created.   

 

http://www.arcgis.com/
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Now select Open in Map Viewer from the screen that loaded. Note that this can be done one of two 

ways: by hovering over the map thumbnail on the left side of the screen, or by selecting the blue Open in 

Map Viewer button from the right side of the screen.  

 

 
 

 

You should now see your ArcGIS Pro map displayed online on the World Wide Web for everybody to 

have access to. Very cool!  
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Note that if you did not check the basemap display box in ArcGIS Pro, your webmap may have come out 

looking like this: 
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If this happened, click Basemap and select Topographic to reload the topographic map layer.  

 

 
 

Once you are sure your basemap is working properly, click Save to save your webmap (otherwise you’ll 

have to make these adjustments every time you open up your map).  
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Once you are finished, click on Share at the top of the screen.  

 

 
 

In the pop-up screen that appears, copy the hyperlink and turn it in so that I have view it online.  
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To be turned in: The web link for your map so that I can view it online. Your URL should be similar to the 

following:  

 

https://ut-

austin.maps.arcgis.com/home/webmap/viewer.html?webmap=c1cfa70855a44e18ab5b5e89b8d8fe7a&am

p;extent=-119.806,19.6315,-78.8929,42.1547 

___________________________________________________________________________ 

 

Summary of Items to be Turned In: 
 

(1) An ArcMap map layout in it showing a map of Texas with evaporation gages, coupled with a graph 

showing evaporation data plotted from the gages. In the presentation of information on maps and charts 

it is important to include sufficient labeling detail so that the information can be clearly and 

unambiguously interpreted. You should include a scale bar to indicate distance, a north arrow to indicate 

direction and labels or legends with units wherever they are needed to interpret map or quantitative 

values. Let’s see some nice cartography!! 

(2) The web link for your map so that I can view it online.  Please include this as part of the document 

that you prepare for (1) and submit the result as a single complete document. 

 

The assignment is due in a week from the date it was assigned in class.  

UT Austin: Please submit your solution through Canvas to assignment “Exercise 1”. 

USU: Please submit your assignment as a single Microsoft word or PDF document in Canvas. 

https://ut-austin.maps.arcgis.com/home/webmap/viewer.html?webmap=c1cfa70855a44e18ab5b5e89b8d8fe7a&amp;extent=-119.806,19.6315,-78.8929,42.1547
https://ut-austin.maps.arcgis.com/home/webmap/viewer.html?webmap=c1cfa70855a44e18ab5b5e89b8d8fe7a&amp;extent=-119.806,19.6315,-78.8929,42.1547
https://ut-austin.maps.arcgis.com/home/webmap/viewer.html?webmap=c1cfa70855a44e18ab5b5e89b8d8fe7a&amp;extent=-119.806,19.6315,-78.8929,42.1547

